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1 Product Features 

1.1 Product overview 

XB6 series slice I/O modules feature a combination of 

couplers and I/O modules. The couplers connect 

extendable I/O modules to a real-time industrial 

Ethernet system. The I/O modules communication 

backplane is equipped with X-bus with high real-time 

performance and a variety of modules. It helps users 

collect high-speed data, optimize system configuration, 

simplify field wiring, and improve system reliability. 

1.2 Product features 

Fewer nodes required 

A node consists of a bus coupler, 1~32 X-bus series I/O modules and an end cover. 

Flexible configuration 

Multiple types of slice I/O modules are offered for free combination. 

Diverse functional expansion options 

Flexible expansion is supported, and a complete range of IO types are provided. It is possible to integrate 

digital, analog, temperature, pulse and other modules to meet different application needs. 

High compatibility 

The coupler communication interface conforms to industrial Ethernet communication standards and 

supports mainstream EtherCAT master stations. 

Support to parameter configuration 

Parameters can be configured and automatically saved. 

High speed 

X-bus on the backplane leads to a maximum scan cycle of 1 ms. 

Easy diagnosis 

An innovative channel indicator design is adopted. As the indicators are placed close to the channels, 

channel status is displayed intuitively and clearly, facilitating detection and maintenance. 
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2 Designation Rules 

2.1 Designation rules 

2.1.1 Coupler designation rules 
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2.1.2 I/O module designation rules 

 

 

I/O characteristics 

Digital Analog 

Code Input Output Code  

A NPN NPN, 0.25 A V -10~+10 V, 0~+10 V 

B PNP PNP, 0.5 A I 4~20 mA, 0~20 mA 

BW PNP PNP, 0.25 A VW -10~+10 V, 0~+10 V 

N NPN/PNP  IW 4~20 mA, 0~20 mA 

AN  NPN, 0.25A TM Thermo resistor, 

thermocouple 

BN  PNP, 0.5A   

2.2 List of common modules 

Model Product description 

XB6-EC2002ST EtherCAT coupler kit (power supply, coupler)  

XB6-P2000 Extended power module 

XB6-3200A/B 32-channel digital input module, NPN/PNP type 

XB6-0032A/B/BW 32-channel digital output module, NPN/PNP type 

XB6-1600A/B 16-channel digital input module, NPN/PNP type 

XB6-0016A/B/BW 16-channel digital output module, NPN/PNP type 

XB6-0800A/B 8-channel digital input module, NPN/PNP type 

XB6-0008A/B/BW 8-channel digital output module, NPN/PNP type 

XB6-1616A/B/BW 16-channel digital I/O module, NPN/PNP type 

XB6-3200N 32-channel digital input, NPN/PNP compatible 

XB6-0032AN 32-channel digital output, NPN type 

XB6-0032BN 32-channel digital output, PNP type 

XB6-0012J 12-channel relay output module 

XB6-A80V 8-channel analog input module 

Optional ranges: 0~+10 V, -10~+10 V XB6-A40V 4-channel analog input module 

XB6-A08V 8-channel analog output module 
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XB6-A04V 4-channel analog output module 

XB6-A80I 8-channel analog input module 

Optional ranges: 0~20 mA, 4~20 mA 
XB6-A40I 4-channel analog input module 

XB6-A08I 8-channel analog output module 

XB6-A04I 4-channel analog output module 

XB6-A80VW 8-channel analog input module 

Optional ranges: 0~+10 V, -10~+10 V 
XB6-A40VW 4-channel analog input module 

XB6-A08VW 8-channel analog output module 

XB6-A04VW 4-channel analog output module 

XB6-A80IW 8-channel analog input module 

Optional ranges: 0~20 mA, 4~20 mA 
XB6-A40IW 4-channel analog input module 

XB6-A08IW 8-channel analog output module 

XB6-A04IW 4-channel analog output module 

XB6-A40TM 4-channel thermal resistor and thermocouple temperature collection module 

XB6-A80TM 8-channel thermal resistor and thermocouple temperature collection module 

XX6-C18_2 Common terminal extended module 
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3 Product Parameters 

3.1 General parameters 

General technical parameters 

Size Power module 106◊61◊22.5 mm 

Coupler module 106◊61◊22.5 mm 

I/O module 106◊73◊25.7 mm 

Weight power module 110 g 

coupler module 80 g 

I/O module  90 g 

Working temperature -10~+60℃  

Storage temperature -20℃~+75℃  

Relative humidity 95%, non-condensing  

Protection degree IP20  

3.2 Power parameters 

Power parameters 

power module Working power supply 18~36 VDC 

Output voltage 5 VDC 

Output current 2 A, 4 A 

coupler module Working power supply 5 VDC 

Working current 400 mA 

I/O module  Working power supply 5 VDC 

3.3 Interface parameters 

EtherCAT interface parameter 

Bus protocol EtherCAT (MDP)  

Number of I/O stations Depending on master station configuration 

Data transmission 

medium 

Ethernet/EtherCAT CAT5 cable 

Transmission distance ≤100 m (distance between stations) 

Transmission rate 100 Mbps 
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Bus interface 2◊RJ45 

3.4 Digital parameters 

Signal type 

Digital input   

Rated voltage 24 VDC (±25%) 

Number of signal points 8, 16, 32 

Signal type NPN/ PNP 

“0” signal voltage (PNP) -3~+3 V 

“1” signal voltage (PNP) 15~30 V 

“0” signal voltage (NPN) 15~30 V 

“1” signal voltage (NPN) -3~+3 V 

Input filtering 3 ms (default)  

Input current 4 mA 

Isolation method Optically-coupled isolation 

Isolation withstand voltage 500 V 

Channel indicator Green LED 

Transistor output    

Rated voltage 24 VDC (±25%) 

Number of signal points 8, 16, 32 

Signal type NPN/ PNP 

Load type resistive load, inductive load 

Single-channel rated current(A/B) Max: 500 mA 

Single-channel rated current(BW) Max: 250 mA 

Port protection Overvoltage and overcurrent 

protection 

Isolation method Optically-coupled isolation 

Isolation withstand voltage 500 V 

Channel indicator Green LED 

Relay output   

Rated voltage 24 VDC (±25%) 

Number of signal points 12 

Isolation method Optically-coupled, relay 

Rated load 5 A 

Channel indicator Green LED 

3.5 Analog parameters 

3.5.1 Technical parameters 

Type 

Analog input  Number of input points 4, 8  

Input signal (voltage type)  0~+10 V, -10 V~+10 V 

(adjustable range) 
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input signal (current type)  0~20 mA, 4~20 mA 

(adjustable range) 

 

Resolution 16 bit  

Sampling rate 

Ax0V ≤1 ksps 

Ax0VW ≤62.5 sps 

Ax0I ≤1 ksps 

A40IW ≤100 sps 

A80IW ≤62.5 sps 

Accuracy 

Ax0V ±0.1% 

Ax0VW ±0.3% 

Ax0I ±0.1% 

Ax0IW ±0.3% 

Input impedance (voltage 

type) 

≥2 kΩ  

Input impedance (current 

type) 

100 Ω  

Isolation withstand 

voltage 

500 V  

Channel indicator Green LED  

Temperature 

input  

Number of channels 4, 8  

Sensor type Thermocouple Thermal resistor 

 K: -200~1370℃ 

J: -200~1200℃ 

E: -200~1000℃ 

S: -50~1690℃ 

B: 50~1800℃ 

Pt100: −200~850℃ 

Pt200: −200~600℃ 

Pt500: −200~600℃ 

Pt1000: −200~600℃ 

Resolution 16 bit  

Sensitivity 0.1℃  

Channel indicator Green LED  

Analog output Number of output points 4, 8  

Output signal (voltage 

type)  

0~+10 V, -10~+10 V 

(adjustable range) 

 

Output signal (current 

type)  

0~20 mA, 4~20 mA 

(adjustable range) 

 

Resolution 16 bit  

Load impedance (voltage 

type) 

≥2 kΩ  

Load impedance (current 

type) 

≤200 Ω  

Accuracy 

A0xV ±0.1% 

A0xVW Not available 

A0xI ±0.1% 

A0xIW ±0.3% 
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Isolation withstand 

voltage 

500 V  

Channel indicator Green LED  

3.5.2 Voltage I/O range selection and code value table 

Voltage I/O range selection and cold value range 

Range selection 0 1 2 3 

Range -10 V~+10 V 0~+10 V -10 V~+10 V 0~+10 V 

Code value range -32768~32767 0~32767 -27648~27648 0~27648 

Voltage input 

formula 
D=(65535/20)*U D=(32767/10)*U D=(55296/20)*U D=(27648/10)*U 

Voltage output 

formula 
U=(D*20)/65535 U=(D*10)/32767 U=(D*20)/55296 U=(D*10)/27648 

Code value table See Table 1 Voltage 

Note: D: code value; U: voltage 

Table 1 Voltage code values 

Range 

voltage 

0 (default)  1 2 3 

Code value Code value Code value Code value 

-10 -32768    -27648    

-9 -29491    -24883    

-8 -26214    -22118    

-7 -22937    -19354    

-6 -19661    -16589    

-5 -16384    -13824    

-4 -13107    -11059    

-3 -9830    -8294    

-2 -6554    -5530    

-1 -3277    -2765    

0 0  0  0  0  

1 3277  3277  2765  2765  

2 6554  6553  5530  5530  

3 9830  9830  8294  8294  

4 13107  13107  11059  11059  

5 16384  16384  13824  13824  

6 19661  19660  16589  16589  

7 22937  22937  19354  19354  

8 26214  26214  22118  22118  

9 29491  29490  24883  24883  

10 32767  32767  27648  27648  

  

Code value= 

(65535/20) *voltage 

Code value= 

(32767/10) *voltage 

Code value= 

(55296/20) *voltage 

Code value= 

(27648/10) *voltage 

  voltage= (Code voltage= (Code voltage= (Code voltage= (Code 
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value*20) /65535 value*10) /32767 value*20) /55296 value*10) /27648 

 

3.5.3 Current I/O range selection and code value table 

Analog current I/O range selection and code value range 

Range 

selection 

0 1 2 3 

Range 4~20 mA 0~20 mA 4~20 mA 0~20 mA 

Code value 

range 

0~65535 0~27648 

Current input 

formula 
D=65535/16*I-16384 D=(65535/20)*I 

D=(27648/16)*I-619

2 
D=(27648/20)*I 

Current output 

formula 

I=(D+16384)*16/6553

5 
I=(D*20)/65535 

I=((D+6192)*16)/276

48 
I=(D*20)/27648 

Code value 

table 
See Table 2 Current code value 

Note: D: Code value; I: current 

Table 2 Current code value 

Range 

selection 

Range 

 

current 

0 (default)  1 2 3 

4-20mA 0-20mA 4-20mA 0-20mA 

Code value 

 

Code value 
Code value 

 

Code value 

0   0    0  

1   3277    1382  

2   6554    2765  

3   9830    4147  

4 0  13107  0  5530  

5 4096  16384  1728  6912  

6 8192  19661  3456  8294  

7 12288  22937  5184  9677  

8 16384  26214  6912  11059  

9 20479  29491  8640  12442  

10 24575  32768  10368  13824  

11 28671  36044  12096  15206  

12 32767  39321  13824  16589  

13 36863  42598  15552  17971  

14 40959  45875  17280  19354  

15 45055  49151  19008  20736  

16 49151  52428  20736  22118  

17 53247  55705  22464  23501  

18 57343  58982  24192  24883  
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19 61439  62258  25920  26266  

20 65535  65535  27648  27648  

21 65535  65535  29376  29030  

22   31104  30413  

22.81423611   32511  31538  

22.96238426   32767  31743  

23   32767  31795  

23.51779514    32511  

23.70298032    32767  

24    32767  

25     

 

Code 

value=65535/16*current-16384 

Code value= 

(65535/20) 

*current 

Code value= 

(27648/16) 

*current-6912 

Code value= 

(27648/20) 

*current 

Notes: 

In Range 2, when input current＞22.81 mA, the code value displayed is always 32767; when the specified Code 

value＞32511, the output current is always 22.81 mA. 

In Range 3, when input current＞23.52 mA, the code value displayed is always 32767; when the specified code 

value＞32511, the output current is always 23.52 mA. 

 

3.6 Common terminal expansion module parameters 

Common terminal 

Rated voltage 125 VDC/AC 250V 

Rated current 8 A 

Number of common terminals 2 sets 
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4 Panel 

4.1 Coupler panel 

The name and function of different coupler parts will be described in this section. 

 

Description of IDs and indicators of the power part 

ID Name Color Indicator status Meaning 

P 5V indicator Green ON Normal status of working power 

supply 

Flashing 80% overload. The power supply 

to real stage load is cut off. 

OFF Unpowered or abnormal power 

supply 

O Overload 

indicator 

Red OFF No overload 

ON 90% overload 

Flashing 80% overload. The power supply 

to real stage load is cut off. 
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Description of IDs and indicators of the system part 

ID Name Color Status Meaning 

P Power 

indicator 

Green ON Normal status of working power 

supply 

   OFF Unpowered or abnormal power 

supply 

L  Green OFF In initialization or unpowered 

   ON X-bus in the process of interaction 

   Flashing: 1 Hz Normal initialization of bottom bus 

   Flashing: 5 Hz Abnormal initialization of bottom 

bus 

   Flashing: 10 Hz Loss of response of an I/O module 

during operation 

E Error 

indicator 

Red ON Abnormal coupler status 

   OFF In initialization, unpowered, or no 

error 

R  Green OFF In initialization or unpowered 

EtherCAT Init status 

   ON EtherCAT OP status 

   Flashing: 5 Hz EtherCAT PreOP status 

   Flashing: OFF for 

1 s, ON for 200 ms 

EtherCAT SafeOP status 

IN  Yellow Flashing Connection established with data 

interaction 

   OFF No data interaction or abnormal 

status 

OUT  Yellow Flashing Connection established with data 

interaction 

   OFF No data interaction or abnormal 

status 

4.2 I/O module panel 

The name and function of different module parts are described in this section. 
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Indicator description 

P Green ON Normal status of working power supply 

 OFF Unpowered or abnormal power supply 

R Green ON Normal system operation 

 Flashing  

1 Hz 

I/O module connected, X-bus system ready for 

interaction 

 OFF Unpowered, no X-bus data interaction, or 

abnormal status 

Input channel 

indicator 

Green ON  Presence of signal input in module detection 

channel  

 OFF Absence of signal input in module channel or 

abnormal signal input 

Output channel 

indication 

Green ON Presence of signal output in module channel 

  ON/OFF Absence of signal output in module channel or 

abnormal signal output 
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5 Installation and Disassembly 

5.1 Installation instructions 

Module installation precautions 

● Ensure that the cabinet is well ventilated. 

● Do not install this equipment near or above any equipment that may cause 

overheating. 

● Make sure to install the module vertically and maintain adequate air circulation around 

it (at least 50 mm air circulation space should be provided above and below the 

module). 

● After the modules are installed, remember to install guide rail fasteners at both ends to 

fix them. 

● Installation/disassembly operation may only be carried out after the power supply is 

cut off.  

Minimum clearance for module installation (≥50 mm) 

 

Make sure the modules are installed vertically 
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Make sure to install guide rail fasteners 

 

 

 

 

 

 

 

5.2 Application configuration 

 

 

 

 

 

 

 

 

 

 

 

 

Application method: 

Different modules can be combined, including power supply, coupler, digital, analog, relay, temperature, 

pulse, encoder interface, step driver and other modules. 

Application configuration: 

Different I/O module combinations can be adopted depending on master station access capacity, number of 

stations, I/O points, function type, and other requirements. 

Configuration rule:  

From left to right, the modules should be arranged in the order of power supply, coupler module, I/O module, 

and end cover (required). 

 

I/O modules 

function modules 

 

 

Coupler module 

 

 

I/O modules 

function modules 

 

 

End cover 

 

 

Extended 

power module 

 

 



XB6 Series EtherCAT Slice I/O User Manual   5 Installation and Disassembly 

Copyright © 2018 Nanjing Solidot Electronic Technology Co., Ltd.                              

18 

 

5.3 Installation and disassembly steps 

Module installation and disassembly 

Module 

installation 

steps 

1. Install the power module on the fixed guide rail first. 

2. Install the coupler and the required I/O modules on the right side 

of the power module. 

3. After installing all required I/O modules, install the end cover to 

complete module assembly. 

4. Install guide rail fasteners at both ends of the power module and 

end cover to fix the module. 

Module 

disassembly 

steps 

1. Loosen the rail fasteners at both ends of the module. 

2. Pry loose the module snap fitting with a slotted screwdriver. 

3. Pull out the removed module. 

5.4 Installation schematic diagrams 

I. Power module installation 

1. Align the power module guide rail slot vertically with the guide rail, as shown below. 
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2. Press the power module with force until a "click" sound is heard. The module is now installed in 

place, as shown in the figure below. 

 

II. Coupler module installation 

1. Align the left slot of the coupler module with the right side of the power module, and push it in as 

shown below. 

 

2. Press the module with force into the guide rail until a "click" sound is heard. The module is now 

installed in place. 

III. I/O module installation 

Install the required IO modules one by one using the same the steps as coupler module installation. 
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IV. End cover installation 

Install the end cover on the right side of the last module using the same installation method as the 

coupler module. 

 

V. Installation of guide rail fasteners 

1. Install a guide rail fastener next to the left side of the coupler, and lock it tightly. 

 

2. Install a guide rail fastener on the right side of the end cover. In this process, first push the guide 

rail fastener towards the coupler to ensure that the module is installed firmly, and then lock the 

fastener with a screwdriver. 
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VI. Disassembly (with a slotted screwdriver) 

1. Using a screwdriver, loosen the guide rail fastener at one end of the module, and move it to one 

side to create a gap between the module and the fastener. 

 

2. Insert the slotted screwdriver into the snap fitting of the module to be removed, and exert force 

along lateral direction of the module (until a click sound is heard). 

Note: Each module has two snap fittings, one on the top and the other at the bottom. Both should 

be operated in this way. 
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3. Remove the module in the reverse order of installation. 

 

5.4 Dimensions 

Power module dimensions  Installation method 

 

 

 

 

 

Coupler dimensions  Installation method 

DIN 35 mm guide rail 

installation 
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Dimensions of middle power module  Installation method 

 

I/O module dimensions  Installation 

method 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

End cover dimensions  Installation method 

DIN 35 mm guide rail 

installation 

 

 

DIN 35 mm guide rail 

installation 

 

DIN 35 mm guide rail 

installation 
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*DIN guide rail dimensions: 35*7.5*1.0, 35*15*1.0 
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6 Wiring  

6.1 Wiring terminal 

Wiring terminal 

Signal wire terminal Number of poles 16 P 

Number of poles 20 P 

Wire gauge 28 -16 AWG  0.2-1.5 mm² 

Power terminal Number of poles 3P 

Wire gauge 26 -12 AWG  0.5-2.5mm² 

Bus interface 2*RJ45 Category 5 or better UTP or STP (STP 

preferred) 

6.2 Wiring instructions and requirements 

Power wiring precautions 

 

 

⚫ The power supply on the module system side and that on the field 

side should be wired separately. Mixing should be avoided. 

⚫ PE should be grounded reliably. 
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Tool and wiring requirements 

Wiring tool required 

As the terminals are based on a screw-free 

design, cable installation and removal can 

realized with a slotted screwdriver (size: ≤  3 

mm). 

 

Stripping length required 

Recommended stripping length: 10 mm 

 

Wiring method 

For a single-strand hard wire, after stripping a 

required length, press the button while inserting 

the single-strand wire. 

 

For a multi-strand flexible wire, after stripping a 

required length, directly connect it or use a 

compatible cold-pressed terminal (tubular 

insulated terminal, as shown in the table below). 

Press the button whiling inserting the wire. 

 

 

Specification of tubular insulated terminal 

Specification Model Cable section area 

(mm²) 

 

Length of tubular insulated terminal L ≥10 mm 

E0510 0.5 

E7510 
0.75 

E7512 

E1010 
1.0 

E1012 

E1510 
1.5 

Length of tubular insulated terminal L ≥10 mm E1518 

                                                                  

Power supply wiring 

3P terminal of power module 

Connect the DC24V power module using the given wiring method based on the circuit shown in 

the figure below, and meanwhile ground the PE reliably (twisted pair cable is recommended for 

power supply). 

⚫ Wiring of coupler, IO modules, and power module in sequence, as shown below:  
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⚫ Wiring of coupler, IO modules, power module, IO modules, and power module in sequence, as shown 

below: 
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Load power supply wiring 

20P terminal on the field side 

Press the signal cable into the wiring terminal by referring to the I/O module wiring diagram and wiring 

method. 

24 VDC power supply is used for loads. Using the given wiring method, connect the power supply according 

to the circuit shown in the left figure. Refer to 6.3 I/O module wiring diagram for details. 

 

Signal terminal wiring 

16P\20P terminal 

Press the signal cable into the wiring terminal by referring to the I/O module wiring diagram and wiring 

method. 

Bus wiring 

Industrial Ethernet bus communication interface 

Standard RJ45 network interface and standard RJ45 connector are adopted. The pins are assigned as 

follows. 

 

 

 

⚫ Category 5 or higher-level double-shielded (braided wire + aluminum foil) STP cable is recommended 

as communication cable. 

⚫ The cable between any two devices should not exceed 100 m. 

 

 

  

Pin signal 

1 TD+ 

2 TD- 

3 RD+ 

4 - 

5 - 

6 RD- 

7 - 

8 - 
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6.3 I/O module wiring diagrams 

In the course of wiring, only one group of positive and negative poles needs to be connected to respective 

points. 

XB6-3200A  Module panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DIa

DIb

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

  

 

XB6-3200B  Module panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DIa

DIb

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F
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XB6-1616A  Module panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

  

 

 

XB6-1616B  Module panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

  

 

XB6-1600A  Module panel 
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Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

  

 

XB6-1600B  Module panel 

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

  

 

 

XB6-0800A  Module panel 
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DI

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

  

 

XB6-0800B  Module panel 

DI

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

  

XB6-0032A  Module panel 
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DOa

DOb

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

  

 

 

XB6-0032B  Module panel 

 

DOa

DOb

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

  

XB6-0016A  Module panel 
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Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

DO

  

 

XB6-0016B  Module panel 

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

DO

  

 

 

 

XB6-0008A  Module panel 
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DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

  

 

XB6-0008B  Module panel 

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

  

 

XB6-0012J  Module panel 
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Power +24V

Power 0 V

Output 0

DOa

Output 1

Output 2

Output 3

Output 4

Output 5 COM

COM

COM

COM

COM

COM

Output 6

Output 7

Output 8

Output 9

Output A

Output B COM

COM

COM

COM

COM

COM

Power +24V

Power 0 V

DOb

  

XB6-A80V/XB6-A80I  Module panel 

COMInput 

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

COM

COM

COM

COM

COM

COM

COM

两线制传感器

+24V

0V
三线制传感器

四线制传感器

+24V

0V

+24V

0V

信号线缆：建议采用屏蔽双绞线*
  

 

 

 

XB6-A40V/XB6-A40I  Module panel 

Note: The screen printing of module 

XB6-A80I is XB6-A80I. 
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COM

AI
Input 

Input 1

Input 2

Input 3

COM

COM

COM

COM

COM

COM

COM

两线制传感器

+24V

0V
三线制传感器

四线制传感器

+24V

0V

+24V

0V

信号线缆：建议采用屏蔽双绞线*
 

 

 

 

XB6-A08V\XB6-A08I  Module panel 

Power +24 V

Power 0 V

Power +24 V

Power 0 V

COMOutput 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

COM

COM

COM

COM

COM

COM

COM

信号线缆：建议采用屏蔽双绞线*
  

XB6-A04V\XB6-A04I  Module panel 

Note: The screen printing of module 

XB6-A40I is XB6-A40I. 

Note: The screen printing of module 

XB6-A08I is XB6-A08I. 
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Power +24 V

Power 0 V

Power +24 V

Power 0 V

COM

AO
Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

COM

COM

COM

COM

COM

COM

COM

信号线缆：建议采用屏蔽双绞线*
 

 

6.4 Common terminal expansion module wiring diagrams 

The wiring method of two-wire and three-wire sensors is described in this section, taking the two modules of 

XX6-1616A/B as examples. 

Wiring method of two-wire sensor (NPN type) 

 

Note: The screen printing of module 

XB6-A04I is XB6-A04I. 
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Wiring method of two-wire sensor (PNP type) 

 

Wiring method of three-wire sensor (NPN type) 

 

Wiring method of three-wire sensor (PNP type) 
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7 Operation 

7.1 Module application 

7.1.1 Application modes 

Two combinations are available for the product as shown below, each containing a coupler, I/O modules 

and an end cover. 

First product combination (coupler, I/O modules, end cover) 

Coupler I/O modules End cover 

 

 

Second product combination (coupler, I/O modules, power module, I/O modules, 

end cover)  

Coupler 
I/O modules 

Power 

module 
I/O modules 

End 

cover 
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The following principles should be adhered to when determining the number of I/O modules: 

● The model and number of I/O modules in the system must be configured in such a way that the 

maximum power consumption is lower than the load current provided by the power module. 

● The number of IO modules that can be supported by a coupler is not higher than 32. 

● The number of analog modules should not exceed 12, and the number of 8-channel analog inputs 

should not exceed 8. 

● One power supply supports up to 10 I/O devices. If there are more than 10 devices, additional power 

supplies will be required. 

7.1.2 Number of power modules configured and power consumption calculation 

Power module configuration principle 

The model and number of I/O modules in the system must be configured in such a way that the maximum 

power consumption is lower than the load current provided by the power module. 

After the model and number of I/O modules are determined, calculation can be made by referring to our 

"Solidot XB6 Series I/O Power Consumption Calculation Table", so as to reasonably configure the 

number of couplers and power modules. 

Website of“Solidot XB6 Series I/O Power Consumption Calculation Table”: 

https://www.solidotech.com/documents/tools 

An example of configuration of couplers and power modules 

Models and number of I/O modules required by the system and corresponding power consumption:  

Type Model Number Power consumption 

IO module 

XB6-3200A 1 55 mA 

XB6-1600A 1 50 mA 

XB6-0032A 4 180 mA 

XB6-0016A 1 110 mA 

XB6-1616A 5 120 mA 

XB6-A80V 1 230 mA 

Total power consumption  1685 mA 

Conclusion:  

Because the total power consumption of all modules is 1685 mA, which is greater than the 1600 mA 

current provided by a coupler for I/O modules, it is necessary to add a power supply module.  

7.2 Coupler functional description 

In this chapter, TwinCAT3 software platform is taken as an example to introduce coupler functions. 

Topological configuration 

https://www.solidotech.com/documents/tools
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The system supports both automatic scan configuration and manual configuration 

⚫ Manual configuration:  

Select a target module in SLOT. The specific location varies with the master station. 

After adding a coupler, enter Slots page and click  and  for topological configuration, as shown 

in the figure below. For details, please refer to: 

7.4.1 Application in TwinCAT3 software environment. 

 

⚫ Automatic scan configuration:  

For details, please refer to: 7.4.1 Application in TwinCAT3 software environment. 

Parameter configuration 

Enable P > S setting to activate parameters. 

After adding a coupler, enter“Startup”page and right click to select “Insert” for parameter configuration, 

as shown in the figure below. 

 

⚫ In the master station, activate the parameter configuration function to configure IO module 

parameters when creating a project.  

⚫ In the master station, use SDO to modify parameters. Upon completion of the operation, the 

module will be automatically saved and take effect immediately. The parameters will always be 

kept before the topology is changed. 

Note: If the equipment is in OP state, when an output module is modified, the output signal will be 

cleared and new parameters will be used for operation immediately. 

Recommendation: Configure the IO modules using the parameter activation mode. After 

configuration, power off the system and then power it on again, so as to confirm whether the 

parameters have been correctly applied. 
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Coupler control word/status word 

 XB6-EC0002 supports two-byte control word (”CouplerState”) and two-byte status word (”CouplerState”), 

as shown in the table below: 

  

CouplerState 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

 Reserved X-bus error code display area 

[15-4] Reserved 

[3-0] X-bus operation status, "0”indicating normal status. 

CouplerCtrl 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

By writing bit 0 of control word CouplerCtrl, output 

modules can maintain continuous channel output 

under abnormal conditions. 

Reserved 

Clear/hold 

[15-1] Reserved 

[0] 

0: default value, clearing control. 

1: holding control, default value:“0”. 

A change takes effect immediately. 
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7.3 Module parameter configuration function 

In this chapter, TwinCAT3 software platform is taken as an example to introduce module parameters, 

functions, and configuration methods. 

7.3.1 Filtering time of digital inputs 

Digital input filtering can prevent unexpected rapid changes in program response input signals. Such 

changes may result from jumping of switch contact or electrical noise. The duration of digital input filtering 

is currently fixed at 3 ms, and all clutters within 3 ms can be filtered out. Separate channel configuration is 

not allowed. 

The 3 ms input filtering time means that a single signal changing from 0 to 1 or from 1 to 0 can only be 

detected after 3 ms has lapsed following such change, while a single high pulse or low pulse shorter than 3 

ms will not be detected. 

7.3.2 Analog filtering configuration function 

Analog input filtering function 

The analog input filtering function can average the data internally after A/D conversion to reduce the 

fluctuation effect on input signals due to noise. 

Analog inputs are subject to moving average processing based on the specified A/D conversion times. 

Filtering function configuration 

Each channel can be configured separately. Configuration range: 1~200, default: 10. 

Sampling rate of 8-channel module: 1.25 KHZ/8 channels (800 us/8 channels) 

Sampling rate of 4-channel module: 2.5 KHZ/4 channels (400 us/4 channels) 

Restart is recommended after completion of configuration. 

1. Single click“TwinCAT Project > I/O > Devices > Device (EtherCAT) > Box 1(XB6-EC002)” to enter the 

configuration interface, and switch to“Startup”page. 

2. Right click“Insert”, as shown in the figure below. 
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3. Double click to select a module of an existing model (XB6-A80V in this example), and select the 

corresponding channel for filtering parameter configuration, as shown in the figure below. 

 

7.3.2 Output clearing and holding function 

Output holding: When the communication is disconnected, the module output channel will maintain its 

output. 

Output clearing: When the communication is disconnected, the module output channel will clear its output. 

Configuration of output emptying and holding function 

TwinCAT3 software platform is taken as an example here to explain how to configure output holding and 

clearing function. 

1. In the tree directory, double click “CouplerCtrl”. 

2. Switch to “Online” page, as shown below. 
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3. Single click “Write”, and modify the value of “CouplerCtrl”. 

 

Set Dec to “0”: clear output. 

Set Dec to “1”: hold output. 

 

  



XB6 Series EtherCAT Slice I/O User Manual  7 Operation 

Copyright © 2018 Nanjing Solidot Electronic Technology Co., Ltd.                              

48 

7.3.4 Analog range selection 

Range selection function is supported for analog modules. See 3.5 Analog parameters for details. 

TwinCAT3 software is taken as an example in this manual to explain how to configure the range of analog 

modules. 

1. In the left navigation tree of the configuration page, select “Box 1(XB6-EC0002)”. 

2. Select an analog module, right click “Insert” and enter “Edit CANopen Startup Entry” page. 

2. Double click to modify the module channel. A “Set Value Dialog” box will pop up, as shown below. Set 

the range as needed. After modification, the module should be restarted. 
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7.4 Bus module configuration description 

7.4.1 Application in TwinCAT3 software environment 

1. Preparation 

Hardware environment 

A computer installed with TwinCAT3 software 

Dedicated EtherCAT shielded cable 

A switching power supply 

Module installation guide rail and fasteners 

The module model and type are shown in the table below: 

Type Model Quantity 

coupler  XB6-EC2002ST 1 

IO module XB6-3200A 1 

 XB6-0032A 4 

 XB60032B 1 

 XB6-A40V 1 

End cover XB6-CVR00 1 

Device configuration files 

Website of configuration files: https://www.solidotech.com/documents/configfile 

Hardware configuration and wiring 

Please operate according to “5 Installation and Disassembly and 6 Wiring. 

2. Add a device configuration file 

Place an ESI configuration file (e.g. “EcatTerminal-XB6_VX.XX_ENUM.xml”) in the installation directory 

of TwinCAT: “C:\TwinCAT\3.1\Config\Io\EtherCAT”, as shown below. 

 

3. Add a device 

1. Start TwinCAT software. 

2. Single click “New TwinCAT Project” to create a new project, as shown below. 

https://www.solidotech.com/documents/configfile
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3. Single click “OK”.  

4. Add a device. 

The module supports two device configuration modes: "automatic scan" and "manual addition". 

⚫ Automatic scan configuration 

1. Single click “I/O > Devices”, and right click “Scan” to scan slave station devices. 

 

2. Check “Local Connection” network card. 
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3. Single click “OK”.  

4. In the pop-up “Scan for boxes” box, select “Yes”, as shown below. 

 

5. In the pop-up “Activate Free Run” box, select “Yes”, as shown below. 

 

Example: The scanned “Box 1(XB6-EC0002)” is a coupler. 

View modules connected to Box1. There are currently four modules connected to it, as 

shown below. 
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⚫ Add a device manually 

1. Single click “I/O > Devices”, and right click “Add New Item”. The following window will pop 

up.  

 

2. Select “EtherCAT > EtherCAT Master”, and single click “OK”.  

3. Select “Ethernet” in the pop-up window. 

4. Single click “I/O > Devices”, and right click “Add New Item”. The following window will pop 

up. 

Select a coupler. 
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5. Add a device. 

 

In “Slots” tab, add a device. 

4. Data interaction 

Digital input:  

Taking XB6-3200B module as an example, the input signal can be monitored in “Inputs” of the module, as 

shown below: 

 

Digital output: 

Taking XB6-0032B as an example, in order to enable output of channel 17 of the module, the following 

operation steps are required: 

1. Select “TwinCAT Project > I/O > Box 1(XB6-EC002) > Module 2(XB6-3200B) > Outputs > Channel 

17”.  

2. Switch to “Online”.  

3. Single click “Write” to set “Dec” as “1”.  
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4. Single click “OK”, and the channel indicator corresponding to the module will light up. 

7.4.2 Application in Sysmac Studio software environment 

1. Preparation 

Hardware environment 

A computer installed with Sysmac Studio software 

Omron PLC: NX1P2 9024DT 

Dedicated EtherCAT shielded cable 

A switching power supply 

Module installation guide rail and fasteners 

The module model and type are show in the table below: 

Type Model Quantity 

coupler  XB6-EC2002ST 1 

IO module  XB6-3200A 1 

 XB6-0032A 4 

 XB60032B 1 

 XB6-A40V 1 

End cover XB6-CVR00 1 

Device configuration files 

Website of configuration files: https://www.solidotech.com/documents/configfile 

Hardware configuration and wiring 

Please operate according to 5 Installation and Disassembly and 6 Wiring. 

Computer IP requirement 

Set the IP address of the computer and that of the PLC to ensure they are in the same network segment. 

2. Add a device description file 

1. Log into Sysmac Studio. 

2. Single click “Create a New Project” button. 

https://www.solidotech.com/documents/configfile
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In the drop-down list of “Device” and “Version”, select “Device”, “Model”, and “Version”. 

3. Select “Controller > Communication Configuration”. 

1. Select a method for connecting the controller online, and enter a “remote IP address”, as shown 

below. 

 

2. Single click “Ethernet Communication Test”, and the system will show a successful test 

message. 

3. Add an XML file 

1. Unfold “Configuration and Setting” in the left navigation tree, and double click “EtherCAT”. 

2. Right click “Main Device”, and select “Display ESI Library”, as shown below. 
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3. In the pop-up “ESI Library” window, single click “Install (File)” button, and select a XML file path. 

4. Add a device 

Add a coupler 

1. Unfold “Configuration and Setting” in the left navigation tree, and double click “EtherCAT” to show 

“Node Setting | Network Setting” page. 

2. In the drop-down list of “All Suppliers” in the right navigation bar, select “Nanjing Solidot Electronic 

Technology Co., Ltd”, as shown below. 

 

3. Double click XB6-EC0002 to add a coupler module, as shown below. 
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⚫ Add an I/O module 

Single device connection: 

1. Select the added coupler module, and right click it to show the menu. Select “Edit Module Setting”, 

as shown below. 

 

2. Place the cursor on “Module”, and single click the module in the right list. Add I/O modules one by 

one according to I/O configuration sequence. 

 

Multi-device cascading: 

1. Selected the added coupler module, and right click it to show the menu. Select “Edit Module 

Setting”.  

2. Single click the top menu bar “Controller > Online”. 

3. Right click the “Main Device” icon, and select “Write Slave Device Node Address”, as shown 

below. Enter a “Setting” different from the “Current Value”. 
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4. Restart PLC and the device simultaneously. 

5. Right click “Main Device” icon, and select “Compare with Physical Network Configuration and 

Merge”. 

5. Configuration download 

Single click “Controller > In Transmission > Transmit to Controller” to send the online data to the 

controller. 

6. Channel test 

In the left navigation tree, double click “I/O Mapping”, and select a corresponding I/O module to view 

and operate channel data. 

 

7. Module parameter configuration 

Output emptying/holding function 

1. Double click “I/O Mapping” in the left navigation tree to show “I/O Mapping” window. 

2. Unfold the node. In the system operation state, Write “01” into “Outputs_CouplerCtrl_F200_01” 

to complete configuration of clearing/holding function. 
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0: clear the output 

1: hold the output 

Analog range selection and filtering configuration 

1. Double click a node in the left navigation tree and select a corresponding input module. 

2. After the system goes offline, single click “Edit Initialization Parameter Setting” button. 

  

3. Range selection and filtering configuration 

It is possible to select a range and set filtering parameters in “Edit Initialization Parameter 

Setting” page. For specific parameters, please refer to 7.3 Module parameter configuration 

function. 
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7.4.3 Application in CODESYS V3.5 software environment 

1. Preparation 

Hardware environment 

A computer installed with CODESYS V3.5 software 

Dedicated EtherCAT shielded cable 

A switching power supply 

Module installation guide rail and fasteners 

The module model and type are shown in the table below: 

Type Model Quantity 

coupler XB6-EC0002 1 

IO module XB6-3200A 1 

 XB6-0032A 4 

 XB60032B 1 

 XB6-A40V 1 

End cover XB6-CVR00 1 

Device configuration files 

Website of configuration files: https://www.solidotech.com/documents/configfile 

Hardware configuration and wiring 

Please operate according to 5 Installation and Disassembly and 6 Wiring. 

2. Install device configuration file 

1. Install EhterCAT XML device description file (“EcatTerminal-XB6_VX.XX_ENUM.xml”) 

1. Log into CODESYS.  

2. Select “Tools > Device Repository”. 

3. Single click “Install”, and select relevant XML file for installation. 

After successful installation, “Device xxxx installed to device repository” will be displayed. 

 

2. Add EtherCAT Master 

https://www.solidotech.com/documents/configfile
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1. Double click “Device(CODESYS Control Win V3 X84)” in the left navigation tree, and single 

click “Scan Network”. 

2. Select a device for network scan, e.g.: 

 

3. Select “Device(CODESYS Control Win V3 X84)” in the left navigation tree, and right click to 

select “Add Device”, as shown below. 

 

4. Select “EtherCAT Master”, as shown below. 
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5. Single click “Add Device”, and press Enter in the Device List box to activate the device. 

3. Configure “EtherCAT Master”.  

1. Double click “EtherCAT Master(EtherCAT_Master)”. 

2. Single click “Browse”, and select “Ethernet” in the pop-up box, e.g.: 

 

4. Configure a device 

The module supports two device configuration modes: "automatic scan" and "manual addition". 

● Automatic device scan 
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1. Select “EtherCAT_Master (EtherCAT Master)”, and single click “Scan For Devices”, as shown 

below. 

 

2. Select “XB6_EC0002”, and single click “Copy All Devices to Project”, as shown below. 

 

The device has been added, as shown below. 
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1. Single click “Online > Multiple”, and select “Always Execute Full Download”. 

2. Single click “Online > Login” in the menu bar. 

● Add a device manually 

Add the modules one by one in their installation order. In the case of wrong order, the system 

will not run normally. 

1. Select “EtherCAT_Master (EtherCAT Master)”.  

2. Right click “Add Device” to show “Add Device” page. Select a coupler, as shown below. 

 

3. Select a coupler and single click “Add Device” to add an I/O module, as shown below. 
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5. Test an IO module 

● Configure IO module bus mode 

1. Single click “Logout” button to exit from PLC. 

2. Double click a coupler to switch to “EhterCAT I/O Mapping” tab. 

3. In the “Always update variables” drop-down list in the bottom right corner, select 

“Enabled1” mode, as shown below. 

 

4. Execute download and single click “Online Multiple”. 

5. Test input and output. 

1. Single click “Log Into” button to log in again. 

2. Double click the coupler, and click “Prepared Value” cell. 

3. In the top menu bar, click “Debug > Write Value”. 
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6. Module parameter configuration 

Output clearing/holding configuration 

1. In the left navigation bar, double click coupler XB6-EC0002. In its “Property” tab, select 

“EtherCAT I/O Mapping” page. 

 

2. In the system operation state, enter “Preset Value”, click “Debug > Write Value”, and modify 

the value of “CouperCtrl”. 

0: clear the output 

1: hold the output 

Analog range and filtering configuration 

1. Enable expert configuration 

Log out. In the left navigation bar, double click coupler XB6-EC0002, and select “Startup 

Parameters” page in its “Property” tab. 

 

2.  Single click “Add” button to show “Select Item from Object Directory” page. 
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It is possible to set the range and filtering parameters in “Select Item from Object Directory” 

page.  

 

 

 

 

 

 

 

 

 

 

  


